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Nortel Networks Software License Agreement

READ THE TERMS AND CONDITIONS OF THIS AGREEMENT CAREFULLY BEFORE 
PROCEEDING TO INSTALL AND USE THIS COMPUTER PROGRAM AND ANY 
ACCOMPANYING USER DOCUMENTATION.

This Nortel Networks Software License Agreement (“License Agreement”) accompanies a 
software product and related documentation (collectively, “Software”) that are owned or licensed 
by Nortel Networks Corporation on behalf of itself and its subsidiaries (collectively, “Nortel”).

1 Grant of License: Subject to the terms of this License Agreement and the payment of the 
applicable license fees, Nortel hereby grants to you, and you accept, a non-exclusive, 
non-transferable right to: (a) install one copy of the Software in a single location on a hard disk 
or other storage device, and to execute such copy solely for your internal use; and (b) store 
another copy of the Software in a single location on a hard disk or other storage device solely 
for backup purposes. Nortel and its suppliers reserve any rights not expressly granted to you 
herein, including without limitation any rights in trademarks included with the Software, any 
rights in copies of the Software, and any other intellectual property rights in the Software.

2 Ownership of Software and Copies: You acknowledge and agree that (a) the Software is a 
proprietary product of Nortel and/or its suppliers protected under United States copyright law, 
patent law, trademark law and/or related international treaty provisions; and (b) elements of 
the software, including without limitation the structure, algorithms, and programming 
techniques are valuable trade secrets of Nortel and its suppliers.

3 Restrictions: Neither concurrent use of the Software, nor installation of the Software through 
a local area network, is permitted without separate authorisation from Nortel, and the payment 
by you of any other license fees. You shall not reverse engineer, decompile, disassemble, or 
otherwise attempt to discover the source code of the Software except to the extend such 
prohibition is contrary to law. You shall not modify, adapt, translate or create derivative works 
based on the Software except as necessary for you to operate the Software on a computer of 
your selection. You shall not rent, lease, sublicense, or otherwise distribute the Software or 
derivative works thereof, but you may transfer all your rights in the Software to another person 
or entity, provided that you transfer this License Agreement and all copies of the Software in 
your possession.

4 Termination: This license is effective upon your clicking the “ACCEPT” button, and shall 
continue until terminated as hereinafter set forth. If you don’t ACCEPT these terms, clicking 
the CANCEL button will signify your rejection of this Agreement and the rights granted 
herein. If you choose to cancel this Agreement you may return this product to the place of 
purchase to receive a refund of any license fees paid. Nortel may terminate this license 
automatically and without notice to you, and require you to return or destroy the Software and 
all copies thereof, if you are in breach of any term hereof. In any event, Article 2 – Ownership 
of Software and Copies, Article 3 – Restrictions, Article 5 - Disclaimer or Warranty, and 
Article 6 – No Liability for Consequential Damages, shall survive termination.
i2050 Software Phone Installation Guide
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5 DISCLAIMER OF WARRANTY: THE SOFTWARE IS PROVIDED ON AN “AS IS” 
BASIS. NORTEL DISCLAIMS ALL REPRESENTATIONS, WARRANTIES AND 
CONDITIONS RELATING TO THE SOFTWARE, INCLUDING BUT NOT LIMITED TO, 
IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR 
PURPOSE AND NON-INFRINGEMENT. NORTEL DOES NOT WARRANT, 
GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE USE, OR THE 
RESULTS OF THE USE, OF THE SOFTWARE IN TERMS OF CORRECTNESS, 
ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE.

6 NO LIABILITY FOR CONSEQUENTIAL DAMAGES: NEITHER NORTEL NOR ANY 
OF ITS AGENTS OR SUPPLIERS SHALL BE LIABLE FOR ANY INDIRECT, 
CONSEQUENTIAL, INCIDENTAL OR EXEMPLARY DAMAGES, OR LOST DATA, OR 
LOST PROFITS, ARISING FROM THE SOFTWARE OR THIS LICENSE AGREEMENT, 
EVEN IF NORTEL OR SUCH AGENT OR SUPPLIER HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES OR LOSSES AND WHETHER ANY SUCH 
DAMAGE ARISES OUT OF CONTRACT (INCLUDING FUNDAMENTAL BREACH) 
TORT (INCLUDING NEGLIGENCE) OR OTHERWISE. NORTEL’S ENTIRE LIABILITY 
FOR ANY CLAIM OR LOSS, DAMAGE OR EXPENSE FROM ANY CAUSE 
WHATSOEVER, WHETHER ARISING IN CONTRACT (ETC.) SHALL IN NO EVENT 
EXCEED THE PRICE PAID BY YOU UNDER THIS LICENSE AGREEMENT. In some 
jurisdictions you may have additional rights in which case some of the above may not apply to 
you.

7 Governing Law: This License Agreement is governed by the laws of Ontario and the federal 
laws of Canada applicable therein. The United Nations convention on Contracts for the 
International Sale of Goods, is expressly excluded. You agree that the Software shall not be 
shipped, transferred, or exported into any country or used in any manner prohibited by the 
United States Export Administration Act, or any other export laws, restrictions or regulations.

8 Notice to United States Government End Users: You acknowledge that any Software 
furnished under this License Agreement is commercial computer software developed at 
private expense and is provided with RESTRICTED RIGHTS. Any use modification, 
reproduction, display, release, duplication or disclosure of this commercial computer software 
by the United States Government or its agencies is subject to the terms and conditions and 
restrictions of the License Agreement in accordance with the United States Federal 
Regulations at 48 C.F.R. Section 12.212 and Subsection 227.7202-3 or applicable subsequent 
regulations.

9 General: Should any term of this License Agreement be declared void or unenforceable, such 
term shall be deemed severable from the remaining terms but shall in no way otherwise affect 
the validity or enforceability of this License Agreement. This License Agreement represents 
the entire agreement between Nortel and you concerning the Software, and supersedes all prior 
understandings and agreements relating to the Software, whether oral or written. The failure of 
Nortel to enforce any of its rights granted hereunder or to take action against you in the event 
that you breach any term hereunder, shall not be deemed to be a waiver by Nortel as to 
subsequent enforcement of rights or subsequent actions in the event of future breaches by you.
P0988431 Issue 04.01
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Preface

This guide describes how to install the Nortel Networks i2050 Software Phone. Review this guide 
before installing, upgrading, or modifying the i2050 Software Phone. 

This guide also contains information regarding the Nortel Networks USB Audio Kit. 

This guide is intended for the person installing the i2050 Software Phone and assumes that the 
Communications Server is installed and initialized.

Symbols used in this guide
This guide uses these symbols to draw your attention to important information:

Acronyms
This guide uses the following acronyms:

Caution: Caution Symbol
Alerts you to conditions where you can damage the equipment.

Warning: Warning Symbol
Alerts you to conditions where you can cause the system to fail or work improperly.

Note: Note/Tip symbol
Alerts you to important information.

ACD Automatic Call Distribution

DHCP Dynamic Host Control Protocol

DNS Domain Name Service

IP Internet Protocol

LAN Local Area Network

NIC Network Interface Card

QoS Quality of Service

TPS Terminal Proxy Server

USB Universal Serial Bus

WAN Wide Area Network
i2050 Software Phone Installation Guide
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Related publications
The following documents provide additional information about configuring and using IP 
telephones:

• Programming Operations Guide

• IP Telephony Configuration Guide

• Software Keycode Installation Guide

After you have successfully installed the i2050 Software Phone, you can access the i2050 
Software Phone help system. This help system describes how to use and configure the i2050 
Software Phone.

How to get help
• USA and Canada

Authorized Distributors - ITAS Technical Support 

Telephone: 1-800-4NORTEL (1-800-466-7835)

If you already have a PIN Code, you can enter Express Routing Code (ERC) 196# 

If you do not yet have a PIN Code, or for general questions and first line support, enter ERC 
338#

Website: http://www.nortelnetworks.com/support 

Presales Support (CSAN) 

Telephone: 1-800-4NORTEL  (1-800-466-7835)

Use Express Routing Code (ERC) 1063#

• EMEA (Europe, Middle East, Africa)

Technical Support - CTAS

Telephone: 00800 800 89009 

Fax: 44 191 555 7980

email: emeahelp@nortelnetworks.com

• CALA (Caribbean & Latin America)

Technical Support - CTAS

Telephone: 1-954-858-7777

email: csrmgmt@nortelnetworks.com

• APAC (Asia Pacific)

Technical Support - CTAS

Telephone: +61 388664627

Fax: +61 388664644

email: asia_support@nortelnetworks.com
P0988431 Issue 04.01
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Chapter 1
Introduction

The i2050 Software Phone is a Voice over IP application that allows people to communicate over 
the LAN and WAN from their computers. It combines the rich set of classic telephony services of 
Nortel Networks IP communications servers along with computer resident directory capabilities. 

The i2050 Software Phone presents the following benefits: 

• offers the rich set of telephony services of Nortel Networks IP communications servers such as 
Meridian 1, CSE 1000, Business Communications Manager, Centrex and SL-100.

• offers the “universality” of a Windows-based application 

• encapsulates the operation of the i2004, providing all i2004 functionality in a familiar 
interface wrapper. As per the i2004, the i2050 Software Phone provides:

— Quality of Service (QoS) and authentication 

— automatic detection of call server location using DHCP

— features and services are provided by the network (such as call features, calling line 
identification and voice mail)

• reduces the set of wires required to the desktop by eliminating the need for separate computer 
and telephone wires

• presents an intuitive, flexible interface including:

— slide out trays that provide access to frequently used features and services

— retracted trays that provide a smaller interface with full operational capabilities for a single 
line

— viewable line status

— 10 item lists for quick dial and call log access from both the main and system tray interface

— allows users to customize the interface and directories

— has a multilingual interface 

— provides programmable macro functions for programming lengthy dialing patterns

— hotkeys map the computer keyboard to application buttons

• can be operated from the Windows system tray, allowing the user to take and place calls 
without interrupting other work

• includes a directory application which provides “one-click” direct dialing, access to a variety 
of directory types, quick dial lists, incoming and outgoing call logs

• interfaces with TAPI applications such as Outlook and ACT!

• provides immediate answers to user questions through online help

• USB Audio Kit provides a controlled high quality audio environment. This adapter provides:

— predictable, absolute audio levels

— uses standard Windows drivers

— requires no additional software or drivers

— in-use lamp connector
i2050 Software Phone Installation Guide
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• user selectable ringing device to alert the user to incoming calls through speakers when the 
headset is not being worn

• supports G.723, G.729 and G.711 codecs for a operation at a variety of network connection 
speeds

The intuitiveness of the i2050 Software Phone interface is based on its similarity and compatibility 
with the ergonomics of the i2004 Internet Telephone and Windows-based applications. Training 
investment with the i2004 and network applications presented using the i2004 are directly portable 
to i2050 Software Phone use.

Moreover, the i2050 Software Phone allows users to customize the interface to their own 
preferences for: 

• volume of speaker and microphone

• type of “receiver and speaker” (handset, headset, or hands-free communication)

• language of interface

• ringer device 

The i2050 Software Phone presents clearly identified windows to allow users to: 

• manage one or more communications in progress

• access local or remote corporate directories

• track and manage records of incoming and outgoing calls 

• access network resident services provided by the call server such as voice mail
P0988431 Issue 04.01
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Chapter 2
Installing the i2050 Software Phone 

This section describes how to install the Nortel Networks i2050 Software Phone and the Nortel 
Networks USB Audio Kit. 

Hardware and software requirements 

Minimum PC requirements 
• Pentium® Pro 200 MHz 

• 128 MB memory (for Windows 2000) 

• 64 MB memory (for Windows 98) 

• 55 MB free hard-drive space (all languages) 

• USB port

• Monitor settings: 16 bit High Color; 800x600 resolution or higher 

Supported Operating Systems 
• Windows® 2000 Professional

• Windows® 2000 Professional Service Pack 1

• Windows® 2000 Professional Service Pack 2

• Windows® 98 

• Windows® 98 Second Edition 

• Windows XP (Home and Professional version)

Pentium is a registered trademark of Intel Corporation. 

Windows is a registered trademark of Microsoft Corporation. 

Note: You must have administrator privileges to install the i2050 Software Phone on 
Windows 2000.

Windows 2000 Power Users can install the i2050 Software Phone if they are granted 
rights to install with elevated privileges by a Windows 2000 administrator. 
For information about how to assign elevated privileges to Power Users for installation, 
refer to your Windows 2000 documentation.
i2050 Software Phone Installation Guide
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USB Audio Kit 
Operation of the i2050 Software Phone requires the use of the Nortel Networks USB Audio Kit. 

The USB Audio Kit provides a high quality predictable audio interface which is highly optimized 
for telephony applications. The USB Audio kit allows the i2050 Software Phone to have an 
absolute and predictable loss and level plan implementation which is necessary to meet TIA-810, 
FCC part 68 and its international equivalents as well as the ADA requirements for the hearing 
impaired. With the USB Audio kit, the i2050 can achieve performance rivaling or surpassing that 
of hardware telephones.

The USB Audio Kit is fully compliant with version 1.1 of the USB Device Specification and 
Windows Plug & Play specifications. It is fully compatible with the suspend and resume functions 
for effective use in battery operated laptops. It is functional on Windows 2000 Professional, 
Windows 98, Windows 98 Second Edition, and Windows Millennium. No drivers or software are 
required for installation. 

In the box 
• USB Headset Adapter

• Installation Guide (English and French)

• USB cord

• Telephony grade monaural headset

• Lower cordset with quick disconnect 

Connectors 
• RJ-9 headset/handset jack

• Accessory jack for “in-use” lamp

• USB device jack 

Specifications 
• Native Audio format: 16 bit linear 8 KHz over USB, limited to 8 bit PCM logarithmic coding 

in hardware 

• OS Compatibility: Windows 98, Windows 98SE, Windows 2000, Windows ME, 
Windows XP

• Power Source: USB power provided from computer 

• Enumeration: Enumerates as USB Composite Device and USB Audio Device 

• Channels: Mandatory control channel for enumeration, Bi-directional isochronous channel 
for audio 

• Electret Microphone Bias: 3 V 

• Maximum SPL Protection: limited in headset 

• In-Use Lamp Connector: Isolated contact closure - polarity insensitive 
P0988431 Issue 04.01
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Installing the USB Audio Headset
1 Connect the coiled lower cord to the headset cord with the Quick Disconnect connector. 

Ensure the Quick Disconnect is securely fastened. 

2 Connect the headset cord to the RJ9 jack on the adaptor. 

3 Connect the USB cable to the headset adaptor and to one of the USB jacks on the back of your 
PC or USB hub. 

4 The first time the headset adapter is plugged in, there will be a delay while the Windows 
operating system configures the device and locates appropriate driver software. During the 
installation you may be prompted to supply the original Windows CD ROM so that the 
Windows operating system can locate drivers. 

5 After you have installed the USB headset adapter, you must use the i2050 Software Phone 
Configuration Utility to select ‘USB Audio Device’. 

USB FAQ 
• My computer doesn't have USB, can I use an add-on USB card?

The computer must have a USB connector. The USB Headset has not been tested on USB add 
on or upgrade cards. Performance or operation is not guaranteed of these cards. 

• I don't have enough USB ports available, can I use a USB hub?

The USB Headset has been tested successfully behind a variety of USB hubs. It is not practical 
to test on all of them but no issues have been uncovered on the ones that have been tested. For 
best results, use a powered hubs. 

Optional In-Use Indicator (not provided with kit) 
A 2.5mm output jack is provided next to the USB connector for activation of a visual in-use 
indicator such as the 1127P Desktop Visual Alerter from Algo Communication Products Ltd. 
(604) 454-3790 / sales@algosolutions.com or equivalent. 
i2050 Software Phone Installation Guide
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Installing the i2050 Software Phone 

There are two methods you can use to install the Software Phone. The installation method you use 
depends on the type of Communications Server you have.

• On a Business Communications Manager system, you download the installation wizard from 
the Business Communications Manager system and run the wizard from your computer.

• On all other Communications Servers, you run the installation wizard from the i2050 Software 
Phone CD.

To install using the i2050 Software Phone CD

1 Exit any programs that are running.

2 Disable any anti-virus programs that are running.

3 Insert the i2050 Software Phone CD into the CD-ROM drive of your computer.
If the install wizard starts, go to step 6. If the install wizard does not start, go to step 4.

4 Double click the My Computer icon and then double click the CD icon.

5 Double click the Setup icon.

6 Follow the instructions on the display to complete the installation.

7 Run the i2050 Software Phone Configuration Tool to assign a server address and to configure 
audio peripherals. 

You can access the i2050 Software Phone from the Start menu at Start>Programs>Nortel 
Network>i2050 Software Phone.

You can access the i2050 Software Phone Configuration Tool from the Windows Control Panel. 

To install using Business Communications Manager

1 Exit any programs that are running.

2 Disable any anti-virus programs that are running.

3 Launch your web browser.

Note: If you have previously installed a version of the i2050 Software Phone, you must 
uninstall the old version (via Add/Remove Programs) before installing this version. 

Note: Install the Nortel Networks USB Audio Kit before installing the i2050 Software 
Phone. By doing this you will be presented with the option of using the USB Audio 
Device during installation of the i2050 Software Phone. 
P0988431 Issue 04.01
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4 In the URL address field, type the Business Communications Manager IP address, including 
the port number 6800. For example: HTTP://10.10.10.1:6800

5 On the Unified Manager front page, click the Install Clients button. 

6 Click the i2050 Software Phone link.

7 Click the Download i2050 Software Phone button. 
A file download window appears.

8 Select Save this program to disk and click the OK button.
The SaveAs dialog appears.

9 Choose a location to save this file to and click the Save button. 
The file begins downloading.

10 When the file is finished downloading, click the Close button.

11 Double-click the i2050SoftwarePhone.exe file.

12 Follow the instructions on the display to complete the installation.

13 If you are using Windows 2000, perform the procedures described in “Additional installation 
steps for Windows 2000” on page 17.

14 Run the i2050 Configuration Utility to assign a server address and to configure audio 
peripherals. For information about how to use the i2050 Configuration Utility, refer to “i2050 
Configuration Utility” on page 20.

You can access the i2050 Software Phone from the Start menu at Start>Programs>Nortel 
Networks>i2050 Software Phone. 

You can access the i2050 Software Phone Configuration Tool from the Windows Control Panel. 

Additional installation steps for Windows 2000
If you are installing the i2050 Software Phone on a computer using Windows 2000, you must:

• install the Windows QoS Packet Scheduler

• install the Nortel Networks i2050 QoS Service

The Windows QoS Packet Scheduler and the Nortel Networks i2050 QoS Server enable 802.1p 
Quality of Service (QoS) on the computer. 

Note: You must include HTTP:// with the address and port number to access Unified 
Manager when you are using Internet Explorer as your browser.

Note: The installation files for the i2050 Software Phone are not deleted by the installation 
wizard. These files are stored in a folder named 
C:\Program Files\Nortel Networks\ClientInstall\i2050 Software Phone. 

You can delete the installation files as they are not needed by the i2050 Software Phone. 
i2050 Software Phone Installation Guide
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Installing the Windows QoS Packet Scheduler

To install the QoS Packet Scheduler:

1 In the Windows Control Panel, click Network and Dialup Connections.

2 Right click the Local Area Connection for the device to be used and click Properties.

3 Click Install.

4 On the Select Network Component Type screen, click Service and then click Add.

5 On the Select Network Service screen, click QoS Packet Scheduler and then click OK.
You may require the Windows 2000 CD-ROM.

Installing the Nortel Networks i2050 QoS Service

Installing the Nortel Networks i2050 QoS Service using the i2050 Software Phone 
CD

1 Exit any programs that are running.

2 Disable any anti-virus programs that are running.

3 Insert the i2050 Software Phone CD into the CD-ROM drive of your computer.
If the install wizard starts, exit from the install wizard.

4 Use Windows Explorer to navigate to the QoS directory on the CD.

5 Double click on the Setup icon in this directory.

6 Follow the instructions on the display to complete the installation.

The Nortel Networks i2050 QoS Service is configured to start automatically as a Windows service 
so no further configuration is required for it. 

Note: You must have administrator privileges to install the QoS Packet Scheduler.

Note: Administrator privileges are required to install the Nortel Networks i2050 QoS 
Service. 

If you have administrator privileges, the Nortel Networks i2050 QoS Service is installed 
as part of the i2050 Software Phone installation.

If you do not have administrator privileges, then an administrator must install the Nortel 
Networks i2050 QoS Service for you using a separate installation. The administrator 
should install the Nortel Networks i2050 QoS Service after both the Windows QoS 
Packet Scheduler and the i2050 Software Phone have been installed.
P0988431 Issue 04.01
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Installing the Nortel Networks i2050 QoS Service using the Business 
Communications Manager

1 Exit any programs that are running.

2 Disable any anti-virus programs that are running.

3 Launch your web browser.

4 In the URL address field, type the Business Communications Manager IP address, including 
the port number 6800. For example: HTTP://10.10.10.1:6800

5 On the Unified Manager front page, click the Install Clients button. 

6 Click the i2050 Software Phone link.

7 Click the Download Nortel Networks i2050 QoS Service button. 
A file download window appears.

8 Select Save this program to disk and click the OK button.
The SaveAs dialog appears.

9 Choose a location to save this file to and click the Save button. 
The file begins downloading.

10 When the file is finished downloading, click the Close button.

11 Double-click on the i2050QoSService.exe file.

12 Follow the instructions on the display to complete the installation.

The Nortel Networks i2050 QoS Service is configured to start automatically as a Windows service 
so no further configuration is required for it. 

Communications Server configuration
After you have finished installing the i2050 Software Phone, you must configure the 
Communications Server to recognize and accept calls to and from the i2050 Software Phone. For 
information about how to configure your Communications Server, refer to the documentation that 
came with your Communications Server.

Note: You must include HTTP:// with the address and port number to access Unified 
Manager when you are using Internet Explorer as your browser.
i2050 Software Phone Installation Guide
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i2050 Configuration Utility 
You configure the i2050 Software Phone using the configuration utility. 

To start the configuration utility using the Control Panel:

1 Click the Start button and then click Settings.

2 Click Control Panel. 

3 Double click the i2050 Software Phone icon. 

To start the configuration utility using the Start menu:

1 Click the Start button and click Programs.

2 Click Nortel Networks and click i2050 Software Phone.

3 Click Configuration Tool.

The configuration utility has tabs for 

• Communications Server 

• Select Sound Devices 

• USB Headset Adapter 

• Server Type

• Additional tabs for system administrators
P0988431 Issue 04.01



Chapter 2  Installing the i2050 Software Phone    21

 

Communications Server 

If your site uses DHCP:

1 Select the Obtain server address automatically option.

Using DHCP is the default method of locating the Communications Server. 
If DHCP is used, no further configuration is required. 

If you are not using DHCP:

1 Select the Use the following server address information option.

2 Enter the name of the communications server and then enter or select the port number.
Or
Enter the IP address of the communications server and then enter or select the port number.

If you do not know the communications server name or IP address and port number, ask your 
communications server administrator. 

Note: To use DHCP, you need a DHCP server with communications server IP 
address values programmed as per the i2004.

Note: Using DHCP may not be appropriate for mobile users. These users commonly 
want to connect to their office communications server rather than the local office 
server.
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Select Sound Devices 

Table 1   Select Sound Devices

Attribute Description

Headset 
Microphone

Allows you to select the microphone used for making calls.
Select USB Audio Device.

Headset Speaker Allows you to select the speaker used for making calls.
Select USB Audio Device.

Ringing Speaker Allows you to select a different speaker as a ringing device. If you select the computer speakers 
rather than on the headset, you can hear the phone ringing when you have taken the headset off.

Audio Quality Allows you to adjust the internal buffering on the computer. This allows you to compensate for 
computer performance. 
If the audio is choppy or broken, move the slider toward Higher Quality.

I use a modem to 
connect to the 
network

Select this option if you are using a low speed connection. 

When you select this option, the i2050 Software Phone reports to the communications server that 
G729 and G723 are the supported codecs. The communications server may select G711 later 
depending upon its programming.

When you clear this option, the i2050 Software Phone reports that it supports G711, G723 and 
G729A/G729AB. Not all servers support all codecs. 
G711 requires high bandwidth; G729 requires medium bandwidth; G723 requires low bandwidth.

Apply to all users Users with administrator privileges (as determined by Windows) can apply selected audio 
settings to all users on this computer.

Note: You can also access the Select Sound Device tab from i2050 Software Phone 
interface by clicking Configure Audio on the System menu or the File menu.
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USB Headset Adapter

Use this screen to configure your USB Headset Adapter.   

Note: You must select the Headset Type to ensure optimal headset performance.

Table 2   USB Headset Adapter

Attribute Description

Version Shows the version of the USB Headset Adapter.
Note: If the USB Headset Adapter is not recognized or has a version number lower than 2.0, the 
other features in this table are grayed out and unavailable.

Headset Type Select the type of headset that you have connected to the USB Headset Adapter.
Due to differences in headset construction, you may not get optimal audio performance when 
using a headset that does not appear on the list. For optimal performance, always use one of the 
headsets that appears on the Headset Type drop list.

Use backlight Select this check box to turn on the backlight for the USB Headset Adapter buttons.
Clear this check box to turn off the backlight for the USB Headset Adapter buttons.

Note: When you enable the backlight, you can use the state of the backlight to quickly determine 
if the i2050 Software Phone is running. When the backlight is on, the i2050 Software Phone is 
running. When the backlight is off, the i2050 Software Phone is not running.

Configure Smart 
Functions

Click this button to set the options that are available when you press the Smart Functions button 
on the USB Headset Adapter. For more information about the Smart Functions button, refer to the 
i2050 Software Phone Help.
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External Lamp Indication

Use this screen to configure your optional external lamp.   

Note: The External Lamp is an optional component. It is normally not included with the 
USB Headset Adapter and must be ordered separately. The external lamp is also known 
as an "In-Use Indicator" lamp.

Table 3   USB Headset Adapter

Attribute Description

Manual Override Select one of the available cadences to enable the Manual Override feature. For a description of 
the available cadences, refer to Table 4 on page 25.
When Manual Override is enabled, you can manually turn on the external lamp using the i2050 
Smart Functions button on the USB Headset Adapter. For more information about the i2050 
Smart Functions button, refer to the i2050 Software Phone Help.
Select None to disable the Manual Override feature.

Headset 
Disconnect

Select one of the available cadences if you want the external lamp to indicate when the headset is 
disconnected from the USB Headset Adapter. For a description of the available cadences, refer to 
Table 4 on page 25.
Select None if you do not want the external lamp to indicate if the headset is disconnected.
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If more than one External Lamp Indication option is enabled and active, the external lamp shows 
the cadence of the option with highest precedence. The precedence of the External Lamp 
Indication options from highest to lowest is: Manual Override, Headset Disconnect, Active Call, 
and then Message Waiting. For example, if there is a message waiting and an active call, the 
cadence for Active Call is used for the external lamp.

Active Call Select one of the available cadences if you want the external lamp to indicate when there is an 
active call on the i2050 Software Phone. For a description of the available cadences, refer to 
Table 4 on page 25.

If the USB Headset Adapter is selected as the Ringing Speaker, the external lamp also indicates 
when there is a call ringing on the i2050 Software Phone. For information about setting the ringing 
device, refer to “Select Sound Devices” on page 22.

Select None if you do not want the external lamp to indicate if there is an active call.
Note: If you select a cadence for Active Call, the external lamp also turns on or flashes when 
another application uses the audio channel for the USB Headset Adapter.

Message Waiting Select one of the available cadences if you want the external lamp to indicate when the i2050 
Software Phone message waiting light is on. For a description of the available cadences, refer to 
Table 4 on page 25.

The i2050 Software Phone message waiting light normally indicates when there is a message 
waiting. However, most systems also turn on or flash the message waiting light when the i2050 
Software Phone is ringing.

Select None if you do not want the external lamp to indicate when the message waiting light is on.

Table 4   External Lamp Cadences

Cadence Description

On The external lamp is on solid.

Flash The external lamp cycles at the following rate: 0.5 seconds on; 0.5 seconds off.

Flicker The external lamp cycles at the following rate: 1.625 seconds on; 0.375 seconds off.

Blink The external lamp cycles at the following rate: 0.5 seconds on; 1.5 seconds off.

Table 3   USB Headset Adapter (Continued)

Attribute Description
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Server Type 

To select your server type:

1 Select the option that matches the communications server you are using.
For example, select BCM if you are using a Business Communications Manager system.

2 ACD agents should also select the Enable Symposium option. 
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QoS

Use this screen to enable Quality of Service (QoS) support on the i2050 Software Phone.  

Table 5   Quality of Service (QoS)

Attribute Description

On Select this option to turn 802.1 QoS on.

When you select this option and the QoS Service is installed and running, the i2050 Software 
Phone adds 802.1q to the i2050 Software Phone packets. It will also assign 802.1p as per the 
Communications Server definition (default 6).

Off Select this option to turn 802.1 QoS off.
When you select this option, the i2050 Software Phone does not add 802.1q to the i2050 
Software Phone packets, regardless of whether the QoS Server is present.

Automatic 
detection

Select this option if you want the i2050 Software Phone to decide if the 802.1 QoS is used.
When you select this option, the i2050 Software Phone will attempt to connect with 802.1q added 
to the packets. If the attempt is successful, then the i2050 Software Phone will use 802.1q for the 
call. If the attempt fails (there is a timeout after approximately 1 second), the i2050 Software 
Phone will attempt to connect again without adding 802.1q to the packets.
This is the default option.

Apply to all users Users with administrator privileges (as determined by Windows) can apply the QoS settings to all 
users on this computer.
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Hardware ID 

Note: This screen is intended for expert users only.

Table 6   Hardware ID

Attribute Description

Hardware ID Do not change the information in the first or last box in the Hardware ID field.
The middle box contains the MAC address for the Ethernet card installed in your computer.

The i2050 Software Phone uses the MAC address of the computer as its hardware ID. You may 
have to change this value if there is more than one Ethernet card in the PC or if the PC is using an 
extranet client which hides the true MAC address. For example, Nortel Networks Contivity 
Extranet Switch uses a single MAC address for all clients. This can potentially cause connection 
issues with your communications server.

Auto-Create Changes the MAC address that appears in the middle Hardware ID box.

If your computer has more than one Ethernet card; and therefore more than one MAC address; 
click the Auto-Create button to cycle through the set of MAC addresses on your computer. 

Firmware Version Shows the software version of the i2050 Software Phone.
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Advanced Audio  

You can use this screen to override the communications server defined values.

Note: This screen is intended for expert users only.

Note: Changing the values on this screen should be considered a last resort if audio 
quality issues are encountered.

Table 7   Advanced Audio

Attribute Description

Use 
Communication 
Server values

The i2050 Software Phone uses the values assigned by the communications server.
This is the normal mode of operation.

Override 
Communication 
Server Values

In very rare cases where audio quality is adversely affected by network performance for a few 
clients, these values may be able to achieve a workable balance of quality.
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Listener IP  

This screen identifies the IP addresses and ports where the i2050 Software Phone is listening for 
UNIStim traffic. You can use this screen to override the port assignments when there is a 
conflicting application on the computer.

Note: This screen is intended for expert users only.

Table 8   Advanced Audio

Attribute Description

Use all addresses The i2050 Software Phone listens to the IP addresses on all of the network interface cards on the 
computer for UNIStim traffic.

This is the normal mode of operation.

Port This value may require adjustment if another application on the computer is using the same port. 
The two applications can co-exist by moving the port or IP address the i2050 Software Phone is 
listening to. 

Use specific 
address

Using a specific address may be useful in cases where there is more than one Ethernet card and 
an application conflict exists.
P0988431 Issue 04.01



Chapter 2  Installing the i2050 Software Phone    31

 

Trace 

This screen can be used to record UNIStim traffic. 

Note: This screen is intended for Nortel Networks personnel only.

Note: For normal operation, the Enable option should be cleared. This disables the 
Trace feature.
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About 

This screen identifies the version of the i2050 Configuration Utility. This always matches the 
version of the i2050 Software Phone application.
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Accessing the i2050 Software Phone help
After you have successfully installed the i2050 Software Phone, you can access the i2050 
Software Phone help system. This help system provides detailed information about how to use and 
configure the i2050 Software Phone.

To access the i2050 Software Phone help from the Primary interface (Enhanced):

1 Start the i2050 Software Phone.

2 On the System menu, click Help.

3 Click Contents.
The i2050 Software Phone help window appears.

To access the i2050 Software Phone help from the Secondary interface (Standard):

1 Start the i2050 Software Phone.

2 On the Help menu, click Contents.
i2050 Software Phone Installation Guide



34    Chapter 2  Installing the i2050 Software Phone

 

Registering the i2050 Software Phone on Business 
Communications Manager

If you are using a Business Communications Manager as your communications server, the first 
time you start the i2050 Software Phone you must register with the Business Communications 
Manager system.

To register your i2050 Software Phone on a Business Communications Manager system:

1 Start the i2050 Software Phone.

2 If a password prompt appears on the i2050 Software Phone display, enter the registration 
password and press the OK soft key.
If you do not know the registration password, contact your system administrator.

3 If a DN prompt appears on the i2050 Software Phone display, enter the DN you want assigned 
to this telephone and press the OK soft key.

After the registration is complete, you do not need to go through the registration steps described 
above unless you deregister the terminal. 

If the i2050 Software Phone cannot register or cannot find the communications server, refer to the 
IP Telephony Configuration Guide for more information about registering IP telephones.
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Troubleshooting 

Application fails to install 

Symptom: During installation the following error message appears:

• Error 1931: The Windows Installer service cannot update the system file <filename>. 

Description: You are trying to install i2050 Software Phone on an outdated version of the 
operating system.

Action: To fix the problem, you may have to upgrade your operating system. Check the Hardware 
and Software Requirements section of this document for the information on supported operating 
system releases. 
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Chapter 3
i2050 Software Phone interfaces

This chapter describes the following i2050 Software Phone interfaces: 

• Primary User Interface, which provides access to features and line appearances

• System Tray Interface, which provides operation of the i2050 Software Phone from the 
Windows system tray 

• Directory Interface, which offers access to internal and external databases (directory, personal 
address book, call logbook, quick-dial lists)
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Primary User Interface
The i2050 Software Phone Primary User Interface provides call control and access to other 
network services. The display area and application buttons are mapped directly from the i2004 
Internet Telephone. Therefore, knowledge of one interface is directly portable to the other, 
reducing training costs.

Figure 1   Primary Interface with retracted trays

Figure 2   Local Directory Quick Access

System Menu Message Waiting Minimize Exit

Display area Interactive keys

Mute

Volume control

Answer

Release

Trays

Information/Help/About

ServicesOutboxInbox

Macros

Hold

Navigation keys

Show Lines

(Answer call/Make call)

Directory

Quit

Copy

Switch Right

See Figure 2

Quick Redial Callers Local
List DirectoryListDials

Switch Left
See Figure 1
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The i2050's Enhanced Skin presents a small user interface which can be expanded by selecting 
various trays.

— Retracted Tray

— Number Pad Tray 

— Lines Tray

— Combo Tray 

— Local Directory Quick Access Trays 

Figure 3   Retracted Tray

• The default presentation is with the 
operational trays retracted. In this 
mode the user can operate most 
features available from the i2004. 
Calls can be answered or made by 
pressing the green off-hook button. In 
this mode the call server will select 
the line to answer or engage. The user 
can also hang-up, hold, retrieve from 
hold, mute, adjust volume and access 
network services such as voice mail.

Figure 4   Number Pad Tray

• Provides a graphic keypad to dial 
numbers on with a mouse. In all tray 
selections numbers can also be dialed 
by using the computer keyboard.

Number Pad
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Figure 5   Lines Tray

• Shows up to six lines or feature keys 
provisioned for the telephone by the 
communications server. The status of 
each line is illustrated by a graphic 
icon (idle, ringing, connected, etc.). 
The line is labeled based on its call 
manager provisioning information.

• Note: The line labels are specified in 
system programming by the System 
Administrator.

Figure 6   Combo Tray

• Combines the Line Tray and the 
Number Pad tray at the expense of the 
removal of the line state icons.

Up to 6 lines
Line labels from
system programming

Line status
icons

Number Pad Line labels from
system programming
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Within the Primary User Interface, the computer keyboard provides hotkeys for one press access 
to common features:

• answer (Enter)

• release (F12)

• hold (F5)

• softkeys/interactive keys (F1-F4) 

• alphabetic keys map to numbers as per i2004 dial-pad mapping 

• arrow keys map to navigation keys

• Alt-V will paste/insert data to the interface (For example, you can copy a phone number from 
Outlook and paste it into the i2050 Software Phone interface.)

Figure 7   Local Directory Quick Access Tray

• The Local Directory maintains lists of 
quick dials, redials and callers. Ten of 
the items in these lists can be viewed 
and dialed directly from the Primary 
User Interface using Quick Access 
Trays.

Name lists stored in

Make call - select line

Make call - default line

local directory

Quick Redials Callers Local
List DirectoryListDials
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System Tray Interface
Many of the i2050 Software Phone features are available from the System Tray Interface. This 
interface allows you to operate the i2050 Software Phone without interrupting your workflow. For 
example, you can answer an incoming call from the system tray without launching the Primary 
User Interface. 

Figure 8   System Tray Interface

Easy access to the Local Directory's Quick Dial, Redail and Caller lists is provided by fly-out 
menus.

Open Primary Interface
(also double click
system tray icon) Launch Local Directory

Play Macros

Local Directory Lists

Make Call
(with dialog for
entering number)

Call Operations

Programmed Lines
(selectable)

Windows System Tray

i2050 icon
(image changes

Lines labels

Line state icons

with call state)
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Figure 9   System Tray Interface - Local Directory Quick Access

Local

System Tray

Quick Dial List

Directory
Lists

i2050 icon
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Local Directory Interface
The i2050 Software Phone Directory Interface allows the user to maintain a personal directory for 
placing calls. The directory may be stored with the i2050 Software Phone itself (by default in a 
local file named Directory.mdb); or linked to external directories. Linking to LDAP, Outlook, 
Windows Address Book (WAB) and ACT! directory types is supported.

Users can create, modify and delete entries in the local directory and may copy entries from 
external directories, the redial list and the caller lists into the local directory (select an entry, right 
click and select "Add to Local Directory …").

Directory lists can be "filtered" in simple or complex ways to show, for example, people who's last 
name starts with 'B' and work for "Nortel Networks".

Ten items from each of the Quick Dial, Caller List ad Redial List are also viewable from the 
Primary User Interface and the System Tray Interface.

The Quick Dial list is a shortcut to entries stored elsewhere (in the local directory or in an external 
directory). Callers list and Redial list are stored as lists within the i2050 Software Phone's 
directory storage file. Some communications servers do not provide caller identification to the 
i2050 Software Phone.
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Figure 10   Directory interface

Calls can be made by selecting a contact entry and then:

• right clicking and selecting which of the contact's numbers to call 

or by

• pressing the call function at the top of the directory window

New Edit Delete Search
Filtered

CallList

Call Logs (Redials and Callers Lists)

Integrated External Directories (LDAP, Outlook, Windows Address Book (WAB), ACT!) 

Quick Dial List 

Local / Personal Directory
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Figure 11   Directory interface - make a call

Figure 12   Directory interface - linking to an external directory

Make a call

(1) Right click on the shortcut bar (2) Select Insert Directory …
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Chapter 4
Nortel Networks i2050 Diagnostic Utility

The Nortel Networks i2050 Diagnostic Utility is intended for use by groups that provide support 
for the Nortel Networks i2050 Software Phone. This utility provides diagnostic information about:

• the i2050 configuration

• the current, or last, session and call

You can display this diagnostic information on the i2050 Diagnostic Utility display, or you can 
save the information in a file. The files created by the i2050 Diagnostic Utility can be viewed 
using any web browser (for example, Internet Explorer) or can be emailed to a support group for 
analysis. 

Starting the i2050 Diagnostic Utility
If you start the i2050 Diagnostic Utility when the i2050 Software Phone is operating, the i2050 
Diagnostic Utility displays information regarding the current session and call. If you start the 
i2050 Diagnostic Utility when the i2050 Software Phone is not operating, the i2050 Diagnostic 
Utility displays information about the last session and call. 

You must run the i2050 Diagnostic Utility in the same user context as the i2050 Software Phone is 
run. For example, if you want to obtain diagnostics regarding Sam, then Sam needs to run both the 
i2050 Software Phone and the i2050 Diagnostic Utility. If Sam runs the i2050 Software Phone and 
later an administrator logs on and runs the i2050 Diagnostic Utility, the diagnostics obtained will 
be for the administrator, not for Sam.

You can start the i2050 Diagnostic Utility using the Start menu or the command line.

Starting the i2050 Diagnostic Tool using the Start menu

1 Click the Start button and click Programs.

2 Click Nortel Networks and click i2050 Software Phone.

3 Click i2050 Diagnostic Utility.

Note: The Nortel Networks i2050 Diagnostic Utility is intended for use by groups that 
provide support for the Nortel Networks i2050 Software Phone.

Note: When you make changes to the i2050 Software Phone using the i2050 
Configuration Utility or the i2050 Software Phone parameters, the changes are reflected in 
i2050 Diagnostic Utility at the next refresh. Normally, the i2050 Software Phone does not 
pickup the values until the i2050 Software Phone has been stopped and re-started. A few 
settings are read on a per-call-basis, but you should not rely on this.
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Starting the i2050 Diagnostic Tool using the command line
To start the i2050 Diagnostic Utility using a command line, you need to know MS-DOS 
commands. If you do not know MS-DOS commands, refer to the documentation that came with 
your computer.

To start the i2050 Diagnostic Utility using a command line:

1 Start an MS-DOS session.

2 Move to the directory where the i2050 Diagnostic Utility is located.
If you do not know the directory where it is located, use the Windows Find command to locate 
the i2050Diag.exe file.

3 Type i2050Diag and press Enter.
The i2050 Diagnostic Utility starts.

Viewing the diagnostic information
The diagnostic information provided by the i2050 Diagnostic Utility is described in the following 
four sections. 

Audio connection data
The audio connection data information applies to the current user of the i2050 Diagnostic Utility.

For audio to be received and transmitted, an RTP stream must be: 

• Open (refer to Audio Started, Receive Stream Closed, Transmit Stream Closed) 

• Started (refer to Audio Started and Audio Stopped) 

• Connected to a transducer (refer to Receive Stream Connected, Transmit Stream Connected 
and Streams Disconnected) 

• Not muted (refer to Mute Status and Current User Data's Headset Speaker)

• Receiving and transmitting data (refer to Receive Stream and Transmit Stream)

Note: If you have downloaded a new version of the i2050 Diagnostic Utility since 
installing the i2050 Software Phone, you must use the command line to start the i2050 
Diagnostic Utility.

Note: If a source is shown, the source indicates where you can view the value and modify 
it if possible: 

• If you can view the value from the i2050 Configuration Utility, the i2050 
Configuration Utility tab appears in bold and the field within that tab appears in 
italics. 

• If you can view the value from the i2050 Software Phone interface, i2050-> appears in 
bold and the menu and field appears in italics.
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Table 9   Audio connection data

Data Description

Stream Volume Volume of the audio stream indicated in percentage.

Alerting Volume Volume of the alerting tone indicated in percentage.

Audio Started Time the last (or current) audio connection started. A currently active audio stream is indicated by 
the comment Active. If there is no currently active audio stream, this is indicated by the comment 
Last Connection.

Receive Stream 
Connected

Time the last (or current) audio receive stream connection started. A currently connected audio 
stream is indicated by the comment Connected. If there is no currently connected receive stream, 
this is indicated by the comment Last Connection.

Transmit 
Stream 
Connected

Time the last (or current) audio transmit stream connection started. A currently connected audio 
stream is indicated by the comment Connected. If there is no currently connected transmit stream, 
this is indicated by the comment Last Connection.

Receive Stream The number of packets and bytes of audio received during the last (or current) connection. The 
time indicates the last time this was updated. Updates occur every 1000 packets.

Transmit 
Stream

The number of packets and bytes of audio transmitted during the last (or current) connection. The 
time indicates the last time this was updated. Updates occur every 1000 packets.

Streams 
Disconnected

The last time the audio streams were disconnected.

Receive Stream 
Closed

The last time the receive audio stream was closed.

Transmit 
Stream Closed

The last time the receive audio stream was closed.

Audio Stopped The time the audio was stopped.

Mute Status Mute status on the i2050 Software Phone is indicated by the color red appearing on the mute 
button. This indication is controlled by the Terminal Proxy Server (TPS). The TPS uses different 
messages to control the state of the mute button and the actual mute condition of the audio. It is 
possible that these two values can get out of sync. The Mute status value here indicates the mute 
status of the audio stream as opposed to the button status.
A second mute control exists. It is shown in the Current User Data section under Headset 
Microphone.

Source: Mute status of the audio stream

Current 802.1p 
(Requires NIC 
Support)

Indicates if the i2050 Software Phone believes it is sending 802.1p (on) or not (off). This may or 
may not be true, depending upon whether the NIC (Network Interface Card) actually supports 
802.1p. If the NIC does not support 802.1p, an on indication here does not mean the computer is 
actually sending 802.1p.

Jitter The jitter parameters used for the last (or current) call. The time of the last jitter update is indicated. 
If the computer is overriding the Communications Server assigned jitter values (Advanced Audio 
Override Communications Server values), this is indicated in the System Data section under Local 
Jitter Settings. 
Source 1: Advanced Audio Use Communications Server values
Source 2: Advanced Audio Override Communications Server values

Open RX 
Stream

The parameters for the last (or current) receive audio stream. The time indicates when the stream 
was opened. Codec selection, frames per packet, RTP/RTCP ports, RTP/RTCP DiffServ and 
802.1p values are reported here. If there is a currently open receive stream, this is indicated by the 
comment Active.

Open Tx Stream The parameters for the last (or current) transmit audio stream. The time indicates when the stream 
was opened. Codec selection, frames per packet, RTP/RTCP ports, RTP/RTCP DiffServ and 
802.1p values are reported here. If there is a currently open transmit stream, this is indicated by 
the comment Active.
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Session data
The session data indicates when a session is started, stopped and in some cases a detailed reason 
why the application was stopped. 

The session data information applies to the current user of the i2050 Diagnostic Utility.

Current User data
The Current User data overrides the System data. When a value is present in this table and 
replicated in the System Data table, the value in use is the value for the current user of i2050 
Diagnostic Utility. When a value is unassigned here, the value in use is the value that appears in 
the System data table.

The current user data information applies to the current user of the i2050 Diagnostic Utility. 

Table 10   Session data

Data Description

Session Start The current connection is indicated by the IP address of the current TPS (Terminal Proxy Server). 
The time indicates when the session was connected. The previous 6 connection starts are also 
indicated by time stamps. 

• Assign Terminal ID is a UNISTIM message that the i2050 Diagnostic Utility uses to indicate 
the start of the session.

Session End The last 6 or 7 connection end times are indicated in this column. 

• Server Switch indicates the session was ended when the TPS instructed the i2050 Software 
Phone to move to another server. In some systems this is done for load balancing reasons.

• internalShutdown indicates the i2050 Software Phone reset on its own. This may be due to 
the user exiting the application. 

• Watchdog Expired indicates a loss of connectivity with the communications server. 
• SoftReset and HardReset indicate the communications server has instructed the i2050 

Software Phone to reset.

Reason More detail on the reason the i2050 Software Phone shutdown, such as Watchdog Expired.

Table 11   Current User data

Data Description

Current Skin The i2050 Software Phone skin selected by the user.
Source: i2050->Select Skin

Language 
Selected

The language selected by the user.
Source: i2050->Select Language

Use 802.1p Indicates whether QoS 802.1p is being used.

Source: QoS 802.1p

I use a modem to 
connect

• Slow connection indicates the check box is selected. 
• Fast Connection indicates the check box is cleared. 

Source: Select Sound Devices I use a modem to connect to the network

PC Audio Buffer The setting for the PC Audio Buffer (Audio Quality Slider).
Source: Select Sound Devices Audio Quality slider
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System Data (All Users)
The System Data information applies to all users on the computer. Many individual items can be 
overridden by a user. To determine a value in use, look first in the Current User Data table. If no 
value is there then look in the System Data table.

Headset 
Microphone

The setting for the Headset microphone. The comment "Muted" indicates the device is muted by 
Windows.
Source 1: Select Sound Devices Headset Microphone
Source 2: i2050-> Configure Audio -> Headset Microphone

Headset Speaker The setting for the Headset speaker.
Source 2: Select Sound Devices Headset Speaker
Source 2: i2050-> Configure Audio -> Headset Speaker

Ringing Speaker The setting for the Ringer volume.
Source 3: Select Sound Devices Ringing Speaker
Source 2: i2050-> Configure Audio -> Ringing Speaker

Table 12   System data

Data Description

Software 
Version

The i2050 Software Phone version.
Source 1: About Version 

Source 2: Hardware ID Firmware Version
Source 3: i2050->About

Hardware ID The value saved on the Communications Server can be viewed on the i2050 Software Phone's 
Services menu. 
Source 1: Hardware ID Hardware ID
Source 2: Services - Set Info - HWID 

Note: On CSE 1000 and Meridian 1 switches, the value displayed on the Service menu and the 
value displayed in the i2050 Diagnostic Utility is slightly different. The first two bytes (31-38) saved 
with the i2050 Software Phone are displayed in the Services menu as their ascii values (18).

Local Address Source: Listener IP 

Server An IP address and port of the server. If DHCP is being used, it will be indicated as such.

Server Type Source: Server Type

Trace Source: Trace

Current Skin Source: i2050->Select Skin

Language 
Selected

Source: i2050->Select Language

Local Jitter 
Settings

If the computer is overriding the Communications Server assigned jitter values, this is indicated by 
the presence of this item. If this item is not present, the application is Using Communication Server 
values. 
Source: Advanced Audio Override Communications Server values

Use 802.1p Source: QoS 802.1p

Table 11   Current User data

Data Description
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Utility Output
This section contains the results saved from the ping and trace route dialog. It only appears if the 
results have been saved. It is overwritten each time the utility dialog saves its data.

Updating the diagnostic information
The diagnostic information that appears on the i2050 Diagnostic Utility is the information that was 
current when you started the i2050 Diagnostic Utility. You can update the diagnostic information 
manually or you can configure the i2050 Diagnostic Utility to update the information 
automatically.

Updating the diagnostic information manually
To update the diagnostic information to reflect any changes that occurred since you started the 
i2050 Diagnostic Utility:

1 On the View menu, click Refresh.
Or
Click the Refresh button on the Toolbar.

The diagnostic information is updated to reflect the most current information. 

I use a modem 
to connect

Slow connection indicates the check box is checked. Fast Connection indicates the check box is 
cleared. 
Source: Select Sound Devices I use a modem to connect to the network

PC Audio Buffer Computer Audio Buffer (Audio Quality Slider)
Source: Select Sound Devices Audio Quality slider

Headset 
Microphone

This value will typically report "No Value Assigned" unless a user with administrator privileges has 
checked the Apply to all users check box on the Select Sound Devices tab.
Source: Select Sound Devices Headset Microphone

Headset 
Speaker

This value will typically report "No Value Assigned" unless a user with administrator privileges has 
checked the Apply to all users check box on the Select Sound Devices tab.
Source: Select Sound Devices Headset Speaker

Ringing 
Speaker

This value will typically report "No Value Assigned" unless a user with administrator privileges has 
checked the Apply to all users check box on the Select Sound Devices tab.
Source: Select Sound Devices Ringing Speaker

Note: The options for updating the diagnostic information are not available when you are 
viewing information from a file.

Table 12   System data

Data Description
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Configuring the i2050 Diagnostic Utility to automatically update the 
diagnostic information

To configure the i2050 Diagnostic Utility to automatically update the diagnostic information, you 
need to set the interval for refresh and turn on the Auto-Refresh option.

1 On the View menu, click Set Refresh Interval.

2 Enter the number of minutes that the i2050 Diagnostic Utility waits between updating the 
diagnostic information.

3 Click the OK button

4 On the View menu, click Auto-Refresh.
Or
Click the Auto-Refresh button on the Toolbar.

The i2050 Diagnostic Utility updates the diagnostic information at the frequency you specified for 
the Set Refresh Interval. 

Saving the current diagnostic information to a file
You can save the diagnostic information you are viewing to a file. You can then view this file later 
using a web browser or the i2050 Diagnostic Utility, or you can send it to your i2050 Software 
Phone support personnel.

To save the current diagnostic information to a file:

1 On the File menu, click Save as.
Or
Click the Save button on the Toolbar.

2 Move to the directory to which you want to save the diagnostic file.

3 Enter a file name and click Save.

Printing the diagnostic information
You can print the diagnostic information you are viewing.

To print the diagnostic information:

1 On the File menu, click Print.
Or
Click the Print button on the Toolbar.
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Changing the printer settings
You can modify printer selection or change the printer setup.

1 On the File menu, click Print Setup.

2 Change the printer settings and then click the OK button.

Sending an email with the diagnostic information
You send an email message that contains the diagnostic information you are viewing.

1 On the File menu, click Send.
The diagnostic information you are viewing is saved to as an HTML file. A send email 
message window then opens with the HTML file as an attachment.

2 Enter the email address of the person to which you want to send the diagnostic information 
and then send the message.

Opening an existing diagnostic file
You can use the i2050 Diagnostic Utility to view a diagnostic information file that you created 
earlier or was sent from another user. 

To open an existing diagnostic file:

1 On the File menu, click Open.
Or
Click the Open button on the Toolbar.

2 Move to the folder where the diagnostic file is stored.

3 Click the file you want to open and then click the Open button.

Closing an existing diagnostic file
When you are finished viewing a diagnostic file, you can close that file.

To close an existing diagnostic file:

1 On the File menu, click Close.

Note: When you are viewing a existing diagnostic file, the Refresh options on the toolbar 
and in the View menu are disabled.

Note: When you close the diagnostic file, the Refresh options on the toolbar and in the 
View menu are enabled.
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Displaying or hiding the Toolbar
The i2050 Diagnostic Utility Toolbar provides one click access to several i2050 Diagnostic Utility 
options. 

To hide or display the Toolbar:

1 On the View menu, click Toolbar.
When a check mark appears beside the Toolbar menu option, the Toolbar appears on the i2050 
Diagnostic Utility display. 

Displaying or hiding the Status Bar
The Status Bar displays information about the current status of the i2050 Diagnostic Utility. 

To hide or display the Status Bar:

1 On the View menu, click Status Bar.
When a check mark appears beside the Status Bar menu option, the Status Bar appears on the 
i2050 Diagnostic Utility display. 

Accessing the i2050 Diagnostic Utility help
To access the i2050 Diagnostic Utility help:

1 On the Help menu, click Documentation.
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Accessing additional information
To access additional information about the i2050 Diagnostic Utility:

1 On the Help menu, click About.
The About window appears.

The About window displays information about the i2050 Diagnostic Utility, such as the version 
number. From this window, you can also access two Microsoft Windows diagnostic utilities by 
clicking the buttons on the window. These buttons are described in the following table.

Exiting the i2050 Diagnostic Utility
To exit from the i2050 Diagnostic Utility:

1 On the File menu, click Exit.

Table 13   Microsoft Windows Utilities

Button Description

System Info Click this button to launch the Microsoft Windows System Information utility. The 
Microsoft Windows System Information utility is a troubleshooting utility that provides 
computer information including:

• System Summary (Operating System type and build, processor, memory, etc.) 
• Hardware Resources
• Components (including USB where the USB audio device appears if it is enumerated 

properly by the Operating System)
• Software Environment
• Internet Explorer information

• Microsoft Applications
You can save this information to a file that you can email back to the support group. 
The Tools menu item within System Information utility also provides access to other 
Microsoft trouble shooting utilities. 

Utilities Click this button to open a window with a server address of the current (or last) Terminal 
Proxy Server (TPS) address. From this window you can change the TPS IP address.

This window also has buttons to ping and trace route the TPS IP address. The number of 
echoes the pings performs is controlled by the "Ping Count" field. The "Use DNS" field 
controls whether the ping and trace route resolve addresses to hostnames using DNS 
(this may cause the ping and trace route to run slower). The ping and trace route results 
are displayed in the encapsulated text window. These utilities can be used to verify 
network connectivity with the TPS, round trip times for ping, network nodes and hops 
between the PC and the TPS address. 
You can save the output window to the diagnostic HTML file that you can then email to 
the support group.
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